
Becoming stronger together

DECEMBER   2018  Edition 



2 Becoming stronger together

2
3
4
5
7
8
9

10

11
15
17
18
19
20
22

Becoming Stronger Together

Strategic Alliance with HMB 
Becoming Stronger Together 

The Impact of Digital Media in 
Business

TTMF CAN 2018

Cross Training makes us Strong

EOQ 3 - Javid Hosein

Movers and Shakers

EOQ4 - Crystal-Marie Salandy 

Long Service Awards 2018 

A Resolution on Resoluions

20 Questions - Laurette Walker

You are needed home - 
10 Safe Driving Tips

Tips and Shortcuts in Microsoft 
Outlook

Braingle 

Recipe 

contents
December 2018 Edition

Becoming stronger 
together



Becoming stronger together
2

Most of us were taught that there is strength in numbers or we know the expression, the whole is greater than the sum 
of its parts. These sayings are simply to make the point that together, the individual parts make the entity stronger. 
And then there is the famous saying by Henry Ford, “Coming together is a beginning, staying together is progress, 
and working together is success.” These sayings apply to most of our relationships in life where two or more persons 
to come together to achieve a common goal. It is this coming together, what we commonly refer to as teamwork, that 
is the inspiration behind the theme of this edition of Insight, ‘Becoming Stronger Together’.

We were never meant to journey this life alone. Our gifts, our talents, our expertise and our life experiences are given 
not only to benefit ourselves, but also to share, instill wisdom and mentor those around us. Other people will do the 
same for us, and this will continue into our older years. The more we work together and learn from each other, the 
greater the impact we will have on our lives and on our future.

The importance of teamwork is most often seen in sporting activities. An example is when star footballers who 
belong to foreign clubs, come home to join the national team. Their performance can be less than what is expected 
because they do not practice with the local players long enough to develop synergies necessary to bring out the 
best in each other. If the preparation of the team is properly managed, then the unique individual strengths will be 
complimented by the strengths of others, maximizing performance, bringing out the best in each 
team member and they will become stronger together.  

Family members, teams, employees and even organisations all work together, to 
achieve a common goal. At Trinidad and Tobago Mortgage Finance Company 
Limited (TTMF), we engaged in a Memorandum of Understanding (MOU) with 
the Home Mortgage Bank (HMB), which was conceived to bring the resources 
of both organizations together to achieve greater results whilst maintaining the 
independence and integrity of both companies. The MOU covers the sharing of 
information, technical and administrative facilities and skills and is the beginning of 
our mutual success. This augurs well for the future as we will be working together to 
achieve greater success for each organization, which ultimately will redound to the 
benefit of our shareholders, stakeholders and customers as we become stronger 
together.

Becoming stronger together 		 By ROBERT C. GREEN - MANAGING DIRECTOR / CEO

Reflections with Robert
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In May 2017, Trinidad and Tobago Mortgage Finance 
Company Limited and Home Mortgage Bank (HMB) 
executed a Memorandum of Understanding (MoU) 
which sought to achieve maximum benefits and 
synergies from the common ownership of both TTMF 
and HMB by the National Insurance Board of Trinidad 
and Tobago; and to derive from such collaboration the 
maximum possible advantages from a close corporate 
alliance whilst maintaining the independence and 
integrity of both companies. Among the initiatives 
under the MoU were: 
1.	 The opportunity to share TTMF’s ICT facilities for 

loan administration, management information and 
online and social media marketing particularly as it 
relates to TTMF’s banking platform; 

2. 	 The management of its entire portfolio of residential 
mortgages by TTMF; 

3. 	 Access to any additional administrative capabilities. 

As a consequence of HMB’s review of its strategic 
direction, which gave rise to the MoU, HMB has also 
realigned its business in keeping with its original 
mandate and has reinstituted as its mission, “to facilitate 
the growth and development of the housing finance 
market by the maintenance of a secondary mortgage 
market funded by capital market activities”. Its vision 
is “to be the leading secondary mortgage institution 
in the local environment with the objective of creating 
liquidity in that market while providing financial returns 
comparable to those obtained by the shareholder on its 
other investments”.

In the execution of its mandate HMB pursued growth 
through its secondary mortgage market operations, 
the origination of primary residential mortgages and 
maintained its presence as an issuer of debt securities 
and mortgage-backed securities in the capital market. 
In charting its strategic direction for the period 2017 
to 2020, HMB reexamined its mandate in respect of 
the development of a system of housing finance and 
in particular, its role in support of the Government’s 
housing policy.  

In the National Budget 2010 - 2011, the Honourable 
Minister of Finance and the Economy articulated the 
intent to consolidate the Government’s mortgage 
interests through the restructure of TTMF and HMB. 
The consolidation would serve to provide sustainable 
funding to the housing sector through these institutions 
by way of affordable mortgage financing and to fund 
the construction of homes by the Ministry of Housing 
and Urban Development through its various housing 
agencies. 

Since the Minister’s announcement, The National 
Insurance Board of Trinidad and Tobago (NIBTT) has 
acquired 100% shareholding in HMB and continues 
to own 51% of TTMF.  The NIBTT has undertaken to 
rationalize its holdings in the two companies ensuring 
the maximization of returns in the best interest of the 
National Insurance programme. The intent of the 
consolidation as articulated by the Minister is therefore 
being fulfilled through NIBTT’s rationalization initiative. 

HMB has refocused its operations on the expansion 
of the secondary mortgage market, while providing 
the necessary funding to TTMF to expand its primary 
portfolios. To this end HMB has exited from the primary 
residential mortgage space, which is well served by 
TTMF and will provide financing facilities for land 
development and commercial projects including multi-
family units.   HMB will introduce developer financing in 
support of the Government’s Public Private Partnership 
for the expansion of the housing stock. In its role as 
a developer of the capital market it will maintain its 
presence in the debt and investment securities markets 
through the development of additional mortgage 
backed securities for sale to investors. 

TTMF continues to partner with the Ministry of Housing 
and Urban Development and its agencies, in its role 
as preferred lender under the Government’s Housing 
Programme, through the provision of the subsidized 
2% and 5% mortgage financing regimes and the 

Strategic alliance with HMB 				  
	 Becoming Stronger Together
	 LAURETTE WALKER – CHIEF FINANCIAL OFFICER

Business Features
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administration of HDC’s License to Occupy (LTO) 
Programme. TTMF has also initiated a staged 
financing programme which is being used towards 
the completion of existing HDC housing inventory.  
It is through the conversion of the LTO’s to long 
term mortgages to the licensees, that the HDC 
obtains funds (among other mechanisms) to 
continue its housing programme.  

It is in the context of HMB’s role in respect of the 
sourcing of funds on the capital market and its 
provision of development financing to housing 
developers and TTMF’s role as the provider of 
take out financing in support of the Government’s 
housing, that the collaboration, that began with 
the MoU, will provide sustainable funding to the 
Government’s housing programme. 

In 2018 our collaboration with HMB continued in 
the area of treasury management, commencing 
with the preparation of a joint treasury operations 
plan which saw TTMF benefiting from ‘just in 
time’ financing by way of the sale of mortgages to 
HMB, in the amount of $904M.  The collaboration 
continues in 2019 and will see an additional $625M 
in mortgages sold to HMB. A joint business plan 
was prepared and it expands the undertakings of 
the MoU to other non-financial areas. These are to 
be implemented in 2019.

Each organisation has a competitive advantage 
and expertise. The combining of these advantages 
in pursuit of NIBTT’s need for improved returns 
and the support of the Government’s housing 
programme, which ultimately is about the provision 
of affordable housing to families of Trinidad and 
Tobago make TTMF and HMB become stronger 
together.  

Continued from page 3

The impact of 
Digital Media 
	 in Business
	Technological innovations have affected the way humans 
communicate.  The invention of the Gutenberg Press forever 
changed our world and gave birth to successive media outlets 
such as newspapers and magazines. Today, one of the most 
effective communication tools for business is digital media. 
Since the advent of the internet, people have come to do 
more and more of their interactions with each other and with 
corporate entities, online. 

Societies are constantly changing, and technology often plays 
a part in that change. Digital Media has afforded brands new 
and innovative ways to reach customers, allowing them to make 
more efficient use of their marketing budgets.  Digital media 
can use audio, video, images and text to convey messages.  

Digital Media gives brands the ability to target the audience 
it wishes to reach. Whether a brand is a small, one-person 
operation, or a multinational corporation, it has an opportunity 
to interact with customers via the internet. The deciding factor 
for success is whether the content is engaging enough to 
attract and maintain the user’s attention. You’ve heard the 
term “viral video” - a video that seemingly pops up from 
nowhere and within a short space of time, becomes the top 
of everyone’s newsfeed. This phenomenon is not something 
that can simply bought, but it is ultimately the quality of the 
content that will determine its success.

Digital Media can help brands fine tune their personalities, 
allowing them to build rapport with customers and cultivate 
meaningful relationships. Never has it been so easy for 
customers to interact with brands and vice versa. This can help 
boost brand loyalty as well as attract new customers in a way 
that doesn’t appear as a hard sell.  Consumers prefer brands 
that engage them through relevant topics, rather than just 
trying to sell to them.

Finally, there is the speed at which digital media can be 
implemented and changed. This results in brands being 
able to respond in real time thus ensuring its relevance and 
appeal.  Digital Media has become a key part of marketing 
communications and any business must ensure that it keeps 
up to date with understanding its importance to its customer 
base. 
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Corporate Social Responsibility refers to the act of a company working within the community in an effort to enhance the 
quality of life of its citizens thereby creating a positive impact on the activities of the recipients. As a socially responsible 
company, we identified one (1) home in each area that we operate and conducted a needs assessment in respect of 
furniture and appliances as well as minor repairs. The TTMF CAN Project (Corporate Assistance for the Needy) is the 
umbrella under which our CSR Project is administered.

In each of the areas, there exists homes for displaced and orphaned children as well as the elderly who are in need of 
basic care. We successfully executed this project for 2018 and the selected homes were supplied with furniture and 
appliances and minor repairs were carried out where necessary. 

At the Holy Name Training Centre in Port of Spain we completed the computer room and conducted minor repairs to 
the bathrooms. For the children at the Amica House in St. Augustine we purchased some much needed furniture and 
installed mosquito screens on the windows. There are babies and young children at the Couva Children’s Home & Crisis 
Nursery, and since the home is located near the river, mosquito screens were installed on all the windows. A PVC ceiling 
was installed at the Hope Centre in San Fernando for children, to address a termite problem. The couch and TV stand 
in the sitting room were also replaced. The Tobago Probation Hostel, houses older children and prepares them for adult 
life. You can imagine their pleasure when they received spa equipment on which they can practice their craft when they 
leave the home. 

TTMF CAN also included a food drive from which 4,820 canned goods were collected and distributed to the homes. 

As a responsible corporate entity, TTMF is committed to its true mandate which is shelter, safety, financial security and 
personal wealth and through volunteerism we have contributed positively to the lives of those less fortunate. We can’t 
help but help.

TTMF CAN 2018
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Cross Training makes us Strong

Cross Training in any organization has several advantages and has become a widespread 
practice across the globe. Some of these advantages include increased worker flexibility, job 
coverage, productivity gains and improved employee relations.

Adding to employees’ skill sets via cross training increases your flexibility. This has an effect 
of benefitting both the employee and the employer. You benefit from enhancing your value 
to the company and other future employers should you move on. The company enjoys a 
more well-rounded staff complement who can take on tasks usually done by others. This is 
especially beneficial when a company’s workforce is very specialized, and worker’s absence 
can mean a loss of productivity due to no other employee being able to fill their role.

Productivity is strengthened as a direct result of cross training. Often during slower periods of 
business, certain departments or personnel may not be fully utilized. This is likely to adversely 
affect the company’s bottom line and could result in a drop-in staff morale. By equipping 
employees to perform other tasks, the effects of these slow periods of operation can be 
mitigated and employee relations improved. It can also help with managing position fatigue, 
a type of stress related to doing the same job repeatedly.  

Employee relations can see a serious boost when cross training is implemented within an 
organization. As you gain a better understanding of the tasks performed by your colleagues, 
you gain an increased level of respect for them. This has been observed to precipitate an 
improvement in employee relations, resulting in a more positive work environment for all 
staff. Your confidence may also increase as you begin to see yourself as a more vital part of 
the organization. A win-win all around - making us strong.

HR Focus

The 
company 
enjoys a 
more well-
rounded staff 
complement 
who can 
take on tasks 
usually done 
by others.
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NEW HIRES:
•	 Nailah Assing 	 Aug-20-18
•	 Kadesha Coker	 Sept-03-18
•	 Nicholas Mohammed	 Sept-03-18
•	 Shari Maule 	 Oct-22-18
•	 Sherwin Samsoondar 	 Dec-03-18
•	 Nahshon Ramlal 	 Dec-03-18

EXITS:
•	 Vernie Shield	 Sept-07-18
•	 Cherise Modeste-Edwards	 Sept-28-18
•	 Azaria Rambaran	 Sept-28-18
•	 Nisha Wilson 	 Sept-28-18

VACATION INTERNSHIP PROGRAMME
Ended – August 30, 2018
•	 Kadesha Coker
•	 Monique Marcano
•	 Wayne Maynard
•	 Aaliyah Peterkin
•	 Stephanie Smith 

REWARD & RECOGNITION – 2018
STARS – July 1, 2018 – December 
12, 2018:

RESULTS ORIENTED
Brandon Basdeo
Corey Joseph Samaroo
Javana Robinson-Glynn
Jazel Moses [3]
Julia Ramjohn
Kayode Redhead
Kester Dickson
Krystal Proudfoot
Kyle Andrews [3]
Marcus Phillip
Mickel Nicholas
Rayna Barrow 
Robin Pantaleon
Steffan Kabul
Symone Young
Timothy Dookhan [2]
Toni De Freitas

CUSTOMER FOCUSED
Bilquees Brown
Chakiel Maloney
Christie-Marie Huggins-Legere
Crystal-Marie Salandy [3]
Davina Jagmohan [2]
Dimitri Songui
Glodean Yan Hip
Isaiah Phillip
Javid Hosein [2]
Karen Charles [2]
Kayode Redhead
Kester Dickson
Kimberly Chinibass [2]
Kishore Singh
Krystle Telesford
Kyle Andrews
Lennis-Ann Howard-Crichlow [2]
Makela Sherman
Marisa Gooding-Charles [3]
McQueda Baird [2]
Michelle Toussaint [3]
Nicole Chang [3]
Robin Pantaleon
Shakuntala Beharrysingh
Shavonne Cox Coudray [4]
Sheldon Romano
Shernelle Richards [6]
Steffan Kabul
Tenilla Henry [3]
Terry Lynch [3]

Tessa Salandy [5]
Valishti Ramdass [2]
Vinessa Lewis
Yvette Maynard

INTEGRITY
Melissa Paul-Saunders

TEAMWORK
Aaron Dyer
Adanna Cornwall
Angel Williams
Calleen Jones-Noel
Chakiel Maloney
Danielle James
Dimitri Songui
Gina St. Hilaire
Glodean Yan Hip
Hanessia Jordan 
Isaiah Phillip
Javid Hosein
Jennifer Joseph-Lovell
Kennysha Superville-Ramdeo
Khalisha Joseph
Kishore Singh
Krystle Telesford
Makela Sherman
McQueda Baird
Michelle Toussaint
Nalini Kumar
Nathalia Garcia
Nickolai Williams
Paige O’Brien
Sharla Maharaj 
Shavonne Cox Coudray [2]
Shernelle Richards [2]
Shirlene Chong Ling
Stacy Patterson
Stefan Garcia
Tenilla Henry
Timothy Rochford
Tricia Williams
Valishti Ramdass

EMPOWERMENT
Jennifer Joseph-Lovell
Kennysha Superville-Ramdeo
Krystle Telesford
Nadine Ammon
Shané Phillips
Stacy Patterson
Terry Lynch
Timothy Rochford
Tricia Williams
Yvette Maynard

Movers & Shakers

MOVERS & SHAKERS:
Lisa Williams – promoted to the position of Assistant 
General Manager, Mortgage Administration effective 
September 3rd, 2018.

Wendy Huggins  - promoted to the position of General 
Manager, Mortgage Services effective October 01, 2018. 

Kharena Chee Wah   - promoted to the position of 
Contact Centre Representative within the Contact 
Centre Unit with effect from October 01, 2018. 

Steffan Kabul   - promoted to the position of Contact 
Centre Representative within the Contact Centre Unit 
with effect from October 01, 2018. 

Nicolette Medford   - promoted to the position of Con-
tact Centre Representative within the Contact Centre 
Unit with effect from October 01, 2018.

Brittany Morris   - appointed to the position of Contact 
Centre Representative within the Contact Centre Unit 
with effect from October 15, 2018.

Kimberly Chinibass   - promoted to the position of 
Contact Centre Representative within the Contact 
Centre Unit with effect from December 03, 2018.

Kevin Jeremiah   - appointed to the position of Mort-
gage Assistant within the Account Servicing Unit with 
effect from December 03, 2018.

EMPLOYEE OF THE 
3rd QUARTER: 

April - June 2018:
Javid Hosein

EMPLOYEE OF THE 
4th QUARTER: 

July - Sept. 2018:
Crystal-Marie Salandy
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Long Service & Employee of the Year Award 2018
Awardees

Parbatie Chin-CheongPatricia Ilkhtchoui

Danielle James

Marc Trestrail Sunil Teeluck

Natalie Hector

Jinelle Charles

Ronise Williams

Tracy De Verteuil

Kayode Redhead

Morrissa Ross

Shane Phillips

Usha GajadharMakela Sherman

Stacy Patterson

Marissa Grenade-Allen Ria Springer

Alisha Seepersad

Avian Harris-Khan Gerard Loney

5 & 6
Years

10 & 11
Years
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Long Service & Employee of the Year Award 2018
Awardees

Marsha Tuckett

Michelle Charles-Burnett

Nadine Ammon

Nisha Callendar

Caren Atwaroo Roma Ahye

Tanisha Douglas

Charlene Williams

Sheldon Romano Padma Bhual-Ali

Afiya MarcialCatherine RobinsonLisa GrantMc Queda Baird

Amita Gangar

Brent Mc Fee

Cheryl Ann Strachan Beverly Springer-Felician

Jennifer Joseph-Lovell

10 & 11
Years

15 & 16
Years

20 & 21
Years

26
Years

Gregory Lynch

36
Years
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Long Service & Employee of the Year Award 2018
Ceremony
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Bits & Bytes

Every year many of us make New Year’s resolutions. Most of us who do, break them. Why do we bother? Well, 
the New Year symbolises leaving behind all of the experiences of the previous year, while ushering in a new 
beginning, a time to make new plans for ourselves and our loved ones, taking on new challenges and planning for 
the future. For us defaulters, maybe we are creating goals beyond our reach. Maybe we should take a little nibble 
which is more manageable instead of the big bite which chokes our plans. So, making resolutions that are easier 
to keep is more practical. Here are a few ideas. 

Losing weight
It is fair to say that losing weight tops the list when it comes to resolutions. This can be a tough undertaking to 
maintain. For the New Year, instead of having a weight loss goal, resolve to exercise more frequently; schedule 
three days a week at the gym instead of seven. The key is to not place lofty goals on yourself but to establish what 
is more realistic and manageable and see how that works.  

Giving up junk food
Thinking about this goal, you may say that it is easier for a camel to go through the eye of a needle. Instead of 
thinking about cutting back, focus on ways you can improve your diet by making simple changes. For example, 
start off by replacing the high calorie dessert with something else you enjoy, like fruit or yogurt. Attempting a total 
withdrawal from dessert after a meal, which you so enjoy, is not realistic and difficult to achieve. 

Travelling and see new places
We all dream of seeing the world, but time and finance can prevent you from travelling abroad. Guess what? You 
do not need to purchase a plane ticket to enjoy new places and cultures. Set a goal to explore areas in Trinidad 
and Tobago that you have never visited. It could be near to you in your community or the many natural attractions 
nationwide.  

Learning a new language
Learning a new language is a challenge, especially when you’re doing it by yourself. Instead of focusing on verb 
tenses and how to construct proper sentences, try to learn just one word a day. Once you get the basics, you can 
increase your goal to two words, then three, then four. You get the picture. 

Stop procrastinating
Overcoming procrastination isn’t easy. It’s a habit that can keep coming back, especially if you try to do too many 
things at once. To stop yourself from becoming overwhelmed, focus on trying to cross one thing off your to-do 
list. Just remember to not get upset if you don’t get it accomplished in one day. If you’re making progress, you’re 
getting somewhere.

Morale of the story? Tackling less could lead to achieving more.

A resolution on resolutions
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20
QUESTIONS WITH 

LAURETTE WALKER
JOINED THE TTMF FAMILY ON: 

November 27, 2017

PREVIOUS EMPLOYER:

Massy Wood Group, Home Mortgage 
Bank, Massy Gas Products & Pricewater-
houseCoopers

 POSITION HELD: 

Finance Team Leader, Senior Manager- 
Finance & Administration, Accountant & 
Senior Auditor

EDUCATIONAL BACKGROUND: 

Holy Name Convent, ACCA

ORIGINALLY HAILS FROM: 

St. James 

CURRENTLY HAILS FROM:  

St. Joseph

Get to know your manager

1. 	 What is your favorite food? 
	 Anything Creole 

2.	 Three words that best describe you?
	 Kind-hearted, forgiving and enjoys 

great food

3.	 One weakness?
	 Too Lenient

4.	 What is your idea of a good time?
	 Sitting on a calm beach at an “all- 

inclusive” resort in the Caribbean 
eating some tasty food with family 
and friends

5.	 What are your Hobbies/Interests?
	 Spending quality time with family and 

friends, eating first, then cooking, 
travelling, reading, watching movies 

6.	 Favorite movie?
	 The Final Recipe

7.	 Best TTMF experience?
	 Teamwork demonstrated by the Blue 

Team members during the doll-house 
construction

8. 	 Personal Motto?
	 “One day at a time”

9.	 Best book you ever read?
	 I do not really have a best book. I 

enjoy suspense novels

10.	 Favorite Colors?
	 Black and Purple 

11.	 What’s your idea of success?
	 Fulfilling my God given purpose be-

fore I die

12.	 Greatest Achievement?
	 Acquiring my own home at a young 

age

13.	 What advice would you give some-
one aspiring to be in your position/a 
similar position?

	 Always strive to deliver the highest 
quality in all that you do

14.	 Who is your Role Model?
	 My Dad 

15.	 Most embarrassing moment?
	 Falling down the stairs in Long Circu-

lar Mall when I was a teenager

16.	 Life changing experience?
	 Sudden death of my mother

17.	 If you had to do something over 
again, would you and what would it 
be?

	 Not get married so young, and yes, I 
have done it again. But I got it right 
the 2nd time 

18.	 Any elusive goals?
	 Finding proper balance in life 
 
19.	 Greatest fear/phobia?
	 Losing my mind/memory 

20.	 One thing you would like to do before 
you die?

	 An Alaskan Cruise
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Safety

Proper road safety habits require a concerted individual and community effort. Our roads are as safe as our most 
dangerous driver. Here are some important tips that will help you play your part:

1.	 Don’t drink and drive – Inhibiting your ability to safely operate a vehicle, not only puts you and your passengers 
at risk, but also the safety of other drivers and pedestrians.

2.	 Don’t speed – Driving at high speeds increases your risk of an accident. Not only is your reaction time shortened, 
but your car’s ability to brake safely can also be affected when travelling at high speeds.

3.	 Wear your seatbelt – Using your car’s safety equipment can mean the difference between life and death and 
the statistics prove this. This includes car seats for children and the proper use of them. 

4.	 Avoid distractions – Electronic devices such as cell phones or tablets should not be used while driving. If you 
must speak on the phone, be sure to use a hands free device or a Bluetooth headset and avoid texting while 
driving.

5.	 Don’t drive tired/drowsy – You should be completely alert when driving so that you can respond quickly if 
danger arises. Being tired or drowsy while driving impairs your ability to react in a time manner.

6.	 Drive according to the weather/road conditions – Slippery roads make it difficult to stop at a safe distance. 
Take road conditions into account when preparing for a long drive, give yourself extra time to arrive if the 
conditions are not ideal.

7.	 Maintain your vehicle – A vehicle that is in good working order is statistically safer. Increase your chances for a 
safe drive by ensuring that your vehicle is regularly maintained.

8.	 Drive defensively – Defensive drivers are less likely to get into accidents. Driving aggressively and making 
sudden lane changes are factors that contribute to accidents.

9.	 Give others space – Do not follow too closely behind other vehicles, if they make a sudden stop or turn, you 
may not have enough space to avoid a collision.

10.	 Watch out for other drivers – It is a good rule of thumb to assume that the other drivers on the road are not as 
safe as you are. This prepares you for any unforeseen action on the part of fellow motorists and improves our 
reaction time.

You are needed home
	 10 Safe Driving Tips



19 Becoming stronger together

Tips and Shortcuts in Microsoft 
Outlook

Here are a few tricks that can revolutionise how you use Microsoft Outlook!

1.	 Organise your emails into folders: Organising your emails into a folder system that identifies emails, by 
sender for example, makes it easier to navigate and minimize the time spent searching for that old email 
among thousands of others. 

2.	 Take advantage of Outlook’s easy email templates: If you find yourself composing the same kind of 
message repeatedly, save one of the emails as a template so that you can quickly reference it in the future. 
Go to File > Save As… > Outlook template, then click on Items > Choose Form… > User Templates when 
you’re ready to put that pre-saved form to use.

3.	 Save important emails, calendar events, and notes as files on your desktop: This helps to streamline your 
inbox and allows you to access crucial messages and events even quicker. Simply drag an email, calendar 
entry, or other note on to your desktop or into a folder or click File > Save As if you would like to save it 
in a specific file format. Then, when you’re ready to access it, double click and it will automatically open in 
Outlook.

4.	 Schedule delivery of an email: Do you want to compose a message now but send it later? Outlook makes 
it easy. Write your email, then go to Options > Delay Delivery > Do not deliver before, then specify the time 
and date you want it to go out. This perfect for crafting a few timely emails if you will be away from your desk 
or on vacation. 

5.	 Display emails as conversations: This feature helps to make those long email threads a little easier to review 
by showing all connected messages in one conversation view. And it is easy to activate - simply click View > 
Show as Conversations.

6.	 Create a calendar event by using natural phrases: Instead of scrolling through the calendar to pick a 
specific date for an appointment or meeting, type phrases like “next Saturday” or “two weeks from now” into 
the date field and let Outlook do the rest.

7.	 Block emails from specific senders: While true anti-spam protection is best deployed by a trusted IT 
professional, you can block junk email by performing specific actions. Click Home > Junk email options, then 
in the new window that opens you can identify which senders (and even which countries) you want to block 
as spam.

8.	 Rely on sticky notes for quick reminders: Press Ctrl + Shift + N from anywhere in the Outlook interface to 
create a new note that can be dragged and positioned anywhere on your screen. This is great for quick tasks 
that don’t need to be manually entered into your calendar.

Bits & Bytes
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BRAINGLE
W	 E	 I	 V	 E	 R	 A	 V	 R	 F
O	 D	 E	 F	 E	 N	 C	 E	 I	 H
R	 V	 B	 P	 X	 E	 C	 Q	 U	 Q
K	 O	 K	 V	 E	 E	 O	 L	 G	 H
I	 I	 S	 A	 C	 T	 T	 K	 N	 J
N	 N	 I	 L	 U	 T	 S	 E	 I	 Y
G	 T	 R	 U	 T	 I	 D	 S	 T	 C
P	 E	 W	 E	 I	 M	 Y	 N	 L	 I
A	 R	 Y	 W	 V	 M	 B	 I	 U	 L
P	 N	 O	 N	 E	 O	 R	 V	 S	 O
E	 A	 P	 A	 S	 C	 G	 F	 N	 P
R	 L	 M	 R	 O	 T	 I	 N	 O	 M
S	 A	 S	 S	 U	 R	 A	 N	 C	 E
E	 C	 N	 A	 I	 L	 P	 M	 O	 C
K	 U	 W	 T	 I	 D	 U	 A	 M	 Z
D	 S	 E	 V	 A	 L	 E	 G	 L	 Y

Fill out the entry form attached with your answers and place it in the specially marked box located in the Reception Area, 2nd 
Floor East. Participants from the branches may forward their entries to Sharon Daniel-Munroe – Corporate Communications 
Department, in a suitably marked envelope. 

The deadline for submission is January 28th, 2019 at 4:15 pm. Late entries will not be accepted.

On your entry form, please include your contact information and indicate your preference for one of the following: Ruby 
Tuesday, TG I Fridays or Zanzi Bar. Only one entry per person is allowed. 

Neither photocopies nor e-mail will be accepted. The first correct entry chosen by random draw will be declared the winner 
and will be announced on January 31st, 2019.

The competition is open to TTMF employees only. Management and staff of the Corporate Communications Department are 
not eligible to enter.

ASSURANCE		  CONSULTING		  INTERNAL		  RISK
AUDIT			   DEFENCE		  MONITOR		  VALUE
COMMITTEE		  EXECUTIVES		  POLICY			  WORKING
COMPLIANCE		  GOVERN		  REVIEW			  PAPERS
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TOTAL TIME: 

Prep: 15 min. 

Bake: 30 min.+ cooling

YIELD: 1 dozen.

Ingredients:
1-1/4 cups semisweet chocolate chips
1 can (15 ounces) garbanzo beans or chickpeas, 
rinsed and drained
3 egg whites
1 egg
2 tablespoons instant coffee granules, optional
2 tablespoons canola oil
1-1/2 teaspoons vanilla extract
1/2 cup packed brown sugar
1/2 teaspoon baking powder
Dash salt
1/2 cup chopped walnuts, optional
 

To help you stay on track with your 2019 weight management goals, we 

have included a gluten-free and flourless dessert for you.

Directions: 
1.	 In a microwave, melt chocolate chips; stir until smooth. Cool slightly.
2.	 Meanwhile, place the beans, egg whites, egg, coffee granules if desired, oil and vanilla in a food processor. Cover 

and process until smooth.
3.	 In a small bowl, combine the brown sugar, baking powder and salt; add to bean mixture. Cover and process until 

combined. Gradually add the chocolate; process until blended.
4.	 Pour batter into a 9-in. square baking pan coated with cooking spray. Sprinkle with walnuts if desired. Bake at 350° 

for 30-35 minutes or until a toothpick inserted in the center comes out with moist crumbs (do not overbake). 
5.	 Cool completely on a wire rack.

Recipe

Gluten-Free Brownies
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